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Online-Schulung: Kanalnetzmodellierung 
Mit InfoWorks ICM 
Version 1.7 (30.06.2020) 

 
Herzlich Willkommen zur Online-Schulungsreihe für InfoWorks ICM. Diese Schulung wurde in enger 
Zusammenarbeit von Innovyze und InnoAqua entwickelt, dem Innovyze-Vertriebspartner im 
deutschsprachigen Raum. Die Schulung soll Sie mit den Grundlagen im Umgang mit InfoWorks ICM 
(kurz: “ICM) für die Kanalnetzmodellierung und Starkregenvorsorge vertraut machen. Konkret 
betrachten dafür wir dabei ein Kanalnetzmodell aus Schottland (Gemeinde „Buckie“).  

 
Zum Ablauf 
Die Bearbeitung des Tutorials erfordert 3-4 Stunden Ihrer Zeit und setzt keine Vorkenntnisse im 
Umgang mit ICM voraus. In diesem Tutorial greifen Sie über Ihre Zugangsdaten per 
Remotedesktopverbindung auf eine virtuelle Maschine zu, auf welcher die Software inkl. 
erforderlicher Kanalnetzdaten bereits für Sie eingerichtet sind. Die virtuelle Maschine, welche wir für 
die Schulung stellen, wird vom Cloudanbieter Microsoft Azure bereitgestellt. Um darauf zuzugreifen, 
wird ein Zugang über Remote Desktop Protocol zu externen Computern benötigt (TCP-Port 3389 in 
der Firewall). Standardmäßig ist dieser aktiviert, kann jedoch aufgrund von IT-
Sicherheitsmechanismen deaktiviert sein.  
Wir empfehlen Ihnen, sich mit der IT-Abteilung Ihres Unternehmens in Verbindung zu setzen, um 

sicherzustellen, dass diese Verbindungen hergestellt werden können. Dies lässt sich durch die 

Öffnung des TCP-Ports 3389 in der Firewall ermöglichen. Alternativ wäre z.B. ein Zugriff über einen 

privaten Rechner/Laptop bei welchem die Firewall diesen Port offen hält. 

Tageszugang (08:00-20:00) 
Bitte beachten Sie, dass Ihr Zugang zur virtuellen Maschine aus technischen Gründen nur zwischen 
08:00 und 20:00 möglich ist. Um 20:00 wird der virtuelle Rechner heruntergefahren und auf seine 
ursprüngliche Konfiguration zurückgesetzt. Zur effizienten Bearbeitung empfehlen wir Ihnen dieses 
Dokument parallel auf einem zweiten Monitor zu öffnen oder dieses ggfs. auszudrucken  

 
Quiz und Teilnahmezertifikat 
Während des Tutorials stellen wir Ihnen 5 Quizfragen (Multiple-Choice).  
Beantworten Sie am besten die Quizfrage direkt und schreiben Sich Ihre Antworten auf, um diese 
später an uns zu übermitteln.  
Wir können Ihre Quizantworten über die Quizplattform Outgrow entgegennehmen. Den Weblink zu 
Outgrow haben Sie zusammen mit Ihren Zugangsdaten erhalten.  
Wir benötigen Ihre Antworten, um Ihnen die erfolgreich absolvierte Schulung zu bestätigen und 
Ihnen Ihr Schulungszertifikat ausstellen zu können. 

 
Wir möchten Sie herzlich dazu einladen, Ihre Lernerfahrung an uns zu übermitteln. Ihr geschätztes 
Feedback ist wichtige Grundlage für die Verbesserung und Bereitstellung zukünftiger 
Schulungsinhalte und Tutorials.  

 
Viel Freude bei der Bearbeitung! 
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Inhalt Tutorial 1: Kanalnetzmodell 
Das Tutorial umfasst folgende Inhalte: 

1. Zugang zur virtuellen Maschine 
2. Erste Schritte in InfoWorks ICM 
3. Aufbau eines Kanalnetzmodells 
4. Importieren der Schacht- und Haltungsdaten  
5. Umgang mit unvollständigen Kanalnetzdaten 
6. Teileinzugsgebiete 
7. Durchführung einer hydraulischen Kanalnetzberechnung 
8. Ergebnisauswertung 
9. Kanalnetzkapazität und Überstauanalyse 
10. Übermittlung der Quizantworten 

 
 

 

1. Zugang zur virtuellen Maschine 
 
Schritt 1: Loggen Sie sich in den virtuellen Rechner mit den Zugangsdaten für das Tutorial ein. Stellen 
Sie sicher, dass Sie mit dem Internet verbunden sind und über gültige Zugangsdaten verfügen. 
Beachten Sie, dass die virtuellen Maschinen nur zwischen 08:00-20:00 zur Verfügung stehen.  
 
Ihre Zugangsdaten für den Tageszugang haben Sie per E-Mail erhalten. Ihre Zugangsdaten bestehen 
aus einer Remotedesktopverbindung (.rdp-Datei), einem ausgewiesenen Benutzernamen und einem 
Passwort. 

• Klicken Sie auf die Remotedesktopverbindung (z.B. InnTrainDE001.rdp), um die 
Remotedesktopverbindung herzustellen. 

 
• Im anschließenden Dialog „Anmeldeinformationen eingeben“, 

tragen Sie Ihre Zugangsdaten ein, die Sie per E-Mail erhalten 
haben: 

o Benutzername:   onlineschulung 
o Passwort:  siehe E-Mail 

• Klicken Sie auf OK. Anschließend erhalten Sie eine Warnung: 
„Die Identität des Remotecomputers kann nicht überprüft 
werden. Möchten Sie die Verbindung dennoch herstellen?“  

• Das Sicherheitszertifikat ist Ihrem Rechner unbekannt. Klicken 
Sie auf „Ja“, um die Verbindung herzustellen.  

 

Die virtuelle Maschine wird gestartet. Warten Sie einen Moment. Beachten Sie folgende Hinweise, 

sollten Sie sich nicht einloggen können: 
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Hinweis: Sollten Sie sich innerhalb einer Windows-Domäne 

befinden, aber nicht direkt oder indirekt (via VPN) mit dem 

Domänen-/Firmennetzwerk verbunden sein und der Login nicht 

erfolgreich sein, drei Optionen: 

• Verbinden Sie sich mit dem Domänen-/Firmennetzwerk 
per Kabel, W-Lan oder VPN; 

• Arbeiten Sie alternativ von einem privaten Rechner; oder 
• Sie können die Innovyze-Domäne verwenden, sollte beide Optionen nicht funktionieren: 

o klicken Sie in diesem Fall auf „Weitere Optionen“, und „Anderes Konto verwenden“, 
um die Domäne von Innovyze (innovyze\) zu verwenden: 

o Benutzername: innovyze\Benutzernamen (z.B. innovyze\onlineschulung) 
o Passwort:   siehe E-Mail 

 
Die virtuelle Maschine wird gestartet.  
 
 
Hinweis zur Performance: 
Sie arbeiten nun in einer virtuellen Cloud-Umgebung. Wenn Sie sich das erste Mal in diese Maschine 
einloggen, haben Sie einen Moment Geduld, bis die Windows-Oberfläche vollständig gestartet ist. Bis 
die maximale Performance innerhalb der Windows-Oberfläche erreicht ist, kann es ein paar Minuten 
dauern. Hintergrund ist, dass Ihr Windows-Benutzer in dieser Maschine zum Zeitpunkt Ihres ersten 
Logins neu erstellt wird. 
 
Schritt 2: Auf dem Desktop wurde eine Verknüpfung zum Ordner („Schulung“) für Sie eingerichtet, in 
welchem sich alle Modelldaten befinden, die Sie für die Schulung benötigen: 

 
 
 
 
 

Sollte InfoWorks ICM nicht automatisch geöffnet werden, 

• Starten Sie InfoWorks ICM per Doppelklick auf die Verknüpfung auf dem Desktop. 
 

Haben Sie auch hier etwas Geduld, wenn die ersten Minuten der Benutzung von InfoWorks ICM 

verzögert sind. Hintergrund ist, dass InfoWorks ICM erst kurz nach Ihrem Login auf der virtuellen 

Maschine installiert wurde. Die Performance wird sich nun immer weiter verbessern.  
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2. Erste Schritte in InfoWorks ICM 
Schritt 3: Erstellen Sie zunächst eine neue Master-Datenbank.  

• File -> Open -> Open/Create master database… 
• Wählen Sie “New”…  und anschließend ein Verzeichnis auf dem Desktop aus, in welchem die 

Kanalnetzdatenbank gespeichert werden soll. Drücken Sie “Save” und anschließend “OK”. 
 

 
 
Schritt 4: Sie haben nun eine Master-Datenbank auf der virtuellen Maschine eingerichtet.  
Auf der linken Seite der Benutzeroberfläche sollten Sie die Master-Database sehen.  
Falls Sie die Master-Datenbank nicht sehen können, klicken Sie im Menü auf Window -> New 
explorer window. 
 
Die Master-Database ist noch leer. Ein Weg, um Modelldaten importieren/exportieren ist es, eine 
transportfähige Datenbank zu verwenden. So können Sie bequem Modelldaten und 
Berechnungsergebnisse zwischen Auftragnehmer und Auftraggeber/Kunde übermitteln. In der 
virtuellen Maschine wurde eine transportfähige Datenbank für Sie hinterlegt mit einigen 
Grundlagedaten und Modellvorlagen, welche wir nun importieren:  

• File -> Open -> Open transportable database.  
• Wählen Sie die transportierfähige Datenbank “Kanalnetzschulung.icmt” aus und klicken Sie 

auf “open”. Diese liegt im verknüpften Ordnerverzeichnis „Schulung“ auf dem Desktop und 
hat die Dateiendung „.icmt“.   

 

  
 

Das Fenster der transportfähigen Datenbank öffnet sich. 
Kopieren Sie die grüne Modellgruppe “Buckie” aus der 
transportfähigen Datenbank (Rechtsklick auf “Buckie”-> 
Copy) und fügen Sie diese links in die Master-Datenbank ein 
(Rechtsklick auf Master Database -> Paste: Buckie (with 
Children)).  
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• Klicken Sie auf das “+”-Symbol, um die in der Modellgruppe “Buckie” 
enthaltenen Modell-Untergruppen sichtbar zu machen. 

 

 

 
• Schließen Sie das geöffnete Fenster der transportierfähigen 

Datenbank.  Wir benötigen dieses nicht mehr. 
• Schließen Sie außerdem die „Start Page“  

 
 
 
Schritt 5: Werkzeuge zur Kennzeichnung der Datenqualität (“data flags”) 
Modelle sind nur so gut, wie deren Eingangsparameter. Daten-Kennzeichnungen (“data flags”) 
ermöglichen es, die Qualität und Quelle der Kanalnetz- und Schachtdaten festzuhalten. Wir können 
mit einer Daten-Kennzeichnung u.a. festhalten, welche Dateneinträge tatsächlich aus einer 
detaillierten Vermessung stammen bzw. ob entsprechenden Daten Annahmen zugrunde liegen, die 
es zukünftig zu prüfen gilt.  
 
Daten-Kennzeichnungen lassen sich individuell definieren und aus anderen Projekten importieren.  
In unserem Beispiel werden wir vordefinierte Daten-Kennzeichnungen verwenden und eine 
Konfiguration der Daten-Kennzeichnung importieren. 

• Wählen Sie File -> Master database settings -> User defined flags 
• Wählen Sie Import und die Datei “Buckie Flags.csv” aus, welche Sie im Ordner „csv“ finden. 

 
Die importierten Datenkennzeichnungen und die zugehörige Beschreibung und Farbe werden 
angezeigt. 

 
 
Klicken Sie OK, um den Dialog zu schließen.  
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Schritt 6: Darstellung von GIS-Daten im GeoPLan 
InfoWorks ICM enthält eine GIS-Oberfläche mit integrierten GIS-Funktionen. Die GIS-Oberfläche 
nennen wir „GeoPlan“.  
In dieser Schulung greifen wir auf eine Reihe von Daten aus Geografischen Informationssystemen - 
sogenannte „GIS-Dateien“ - zurück, und verwenden diese für verschiedene Aspekte des 
Modellerstellungsprozesses. Die im Schulungsordnerverzeichnis bereitgestellten GIS-Dateien sind 
sowohl im MapInfo-Format (* .tab) als auch im ESRI-Format (* .shp) verfügbar. Abhängig von Ihrem 
bevorzugten GIS-Anbieter kann jeder Typ in InfoWorks ICM verwendet werden.  
Sollten Sie als Anwender über keinen Zugang zu einer lizenzpflichtigen GIS-Software wie 
beispielsweise MapInfo oder ESRI verfügen, verwenden Sie einfach die bereits installierte 
Drittanbieter-Komponente “MapExtreme”. Auf diese Weise können Sie auch GIS-Dateien von 
MapInfo- oder ESRI-GIS-Systemen öffnen, lesen und schreiben.  
 
In diesem Tutorial werden wir MapExtreme als GIS-Komponente verwenden, da diese bereits in der 
Lizenz von InfoWorks ICM enthalten ist.  

 

3. Aufbau eines neuen Kanalnetzmodells 

Ihre neue Datenbank enthält eine Modellgruppe namens "Buckie".  

Schritt 7: Erstellen Sie ein neues Modellnetz unter der Modellgruppe im linken Bereich der 
Benutzeroberfläche (Master Database) 

• indem Sie mit der rechten Maustaste auf die grüne Modellgruppe “Buckie” und New 
InfoWorks -> InfoWorks network auswählen.  

• Geben Sie dem neuen Modellnetz den Namen “Eigenes Kanalnetzmodell”.  
 

 
 
 
 
 
 
 
 

• Sobald es angezeigt wird, ziehen Sie das das neu erstellte Model Network („Eigenes 
Kanalnetzmodell) in den freien Bereich in der Mitte der Benutzeroberfläche.  Die GIS-
Oberfläche (GeoPlan-Fenster) öffnet sich anschließend. 

• Verkleinern Sie das Fenster der Master Database, in dem Sie mit der linken Maustaste 
gedrückt auf den rot markierten Fensterrand drücken und diesen etwas nach links 
verschieben. Sollte im unteren Bereich der Benutzeroberfläche das Fenster „window job 
control“ zu viel Platz einnehmen, ziehen Sie den Fensterrand ein kleines Stück nach unten. 

• Sie sehen den GeoPlan des noch leeren Kanalnetzmodel („Model network“) vor sich im 
GeoPlan. Maximieren Sie das GeoPlan-Fenster. 
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Schritt 8: Koordinaten-Bezugssystem definieren 
Wir müssen das Koordinatensystem für die räumliche Darstellung des Modellnetzes festlegen, um 
sicherzustellen, dass unsere Modellnetz- und GIS-Daten korrekt im GeoPlan projiziert werden.  

• Wählen Sie über die obere Menüleiste -> GeoPlan -> Set coordinate system.  

In unserem Beispiel verwenden wir ein Kanalnetz aus Schottland. Das Modellnetz sowie die 
hinterlegten GIS-Daten verwenden das Britische Koordinatenbezugssystem „British National Grid 
[EPSG 27770]“. 

• Wählen Sie das Dialogfeld (“ … “) und wählen Sie dort über die Suchfunktion das “British 
national Grid” aus.  

• Nachdem Sie dieses Koordinatenbezugssystem gewählt haben, klicken Sie auf OK. 

 

 

 

 

 

Schritt 9: GIS-Layer hinzufügen (optional) 
Wir möchten nun verfügbare GIS-Dateien in der GIS-Oberfläche (GeoPlan) darstellen. 

• Klicken Sie mit der rechten Maustaste in den GeoPlan und 
wählen Sie “GIS layer control ...”). 

• Wählen Sie “Add”, navigieren Sie zum Ordnerverzeichnis 
“Hintergrundlayer” innerhalb des Schulungsordners auf 
dem Desktop und fügen Sie die vier folgenden Dateien 
hinzu (Dateien auswählen -> Klick auf Open).  

o Gebaeude.shp 
o Strassen.shp 
o Gezeiten.shp 
o Gewaesser.shp 

• Alle vier SHP-Dateien werden nun als GIS Layer erkannt. 
Deaktivieren Sie jeweils den Haken „Selectable“, da wir die 
Daten lediglich anzeigen wollen. 

• Klicken Sie auf OK, um den Dialog zu schließen.  

 

Tip: Um zu den GIS-Layern zu navigieren, klicken Sie mit der rechten 
Maustaste in den GeoPlan und wählen “View entire GIS layer” und 
wählen Sie nun eine der SHP-Dateien aus und wählen OK, um den Layer in 
den Fokus des GeoPlans zu rücken.  
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Tip: Halten Sie die Scroll-Taste Ihrer Maus gedrückt, um innerhalb des GeoPlans zu navigieren 

(Panning). Alternativ können Sie auch die Pan-Funktion über die  Schaltfläche betätigen. 

 

Sie können nun optional die Darstellung der GIS-Layer verändern.  

• Rechtsklick in GeoPlan -> GIS Layer Control 
• Wählen Sie einen Layer aus und öffnen Sie die Anzeigendarstellung des ausgewählten Layers 

über „Properties“. 
• Klicken Sie auf den in der Abbildung blau eingekreisten Bereich, um die farbliche Darstellung 

des jeweiligen Layers anzupassen. 
o Gezeitenlinie zum Beispiel bläulich (Klicken Sie auf eine Farbe im Bereich „Color“, s. 

Abb.). Klicken Sie OK. Die Schaltfläche Apply bewirkt, dass die farblichen Änderungen 
direkt angezeigt werden, ohne den GIS-Layer Control zu schließen.  

o Passen Sie auch die anderen Layer an (Straßen in schwarz; Gewässer-Layer in blau; 
Gebäude-Layer etwas rötlich („Foreground Color“)) 

 

 

 

 

 

 

  



9 
 

  

4. Importieren der Schacht- und Haltungsdaten  

Schritt 10: Schacht- und Haltungsdaten aus GIS-Daten importieren 
Nun werden wir die vorhandenen Kanalnetzdaten aus zwei GIS-Dateien in unsere Datenbank 
importieren, nämlich Schachtdaten (Schacht=”Node”) und Haltungsdaten (Haltung=”Conduit”). 
InfoWorks ICM verfügt über effiziente Schnittstellen zum Import und Export von Modellnetzdaten.   
Beginnen wir mit dem Import der Schachtdaten. Dazu verwenden wir den Open Data Import Centre. 

• Klicken Sie in der Menüleiste auf Network -> Import -> Open Data Import Centre 
• Hier sind die Schachtdaten als Typ bereits ausgewählt („Node“). Wählen Sie als Datenquelle 

(“Source Type”) Raw Shape File aus. Klicken Sie auf das Dialogmenü (...), um zum 
Ordnerverzeichnis „Kanalnetzdaten“ zu navigieren. Wählen Sie „nodes.shp“ und -> open. 

• Klicken auf “Auto-Map”, um automatisch die Attribute der GIS-Datei mit den Attributen der 
Kanalnetzdatenbank zu verknüpfen. 

• Klicken Sie auf Import.  
 
Ein Hinweis informiert Sie, dass 97 Objekte (Schächte) 
importiert wurden. -> OK -> Close.  
Die Schachtdaten sind nun im GeoPlan sichtbar.  

 

Als nächsten Schritt importieren wir die Haltungsdaten.  

• Network -> Import -> Open Data Import Centre 
• Wählen Sie statt “Node” nun “Conduit” aus und wählen die SHP-Datei “pipes.shp”  
• Klicken Sie wie zuvor auf „Automap“ und anschließend auf „Import“. 

 
Eine Hinweismeldung zeigt an, dass 92 Haltungen importiert wurden. 

• Schließen Sie das Fenster (OK) und den Open Data Import Centre (Close). Auch die 
Haltungsdaten sollten nun im GeoPlan sichtbar sein.  
 

Tip: Klicken Sie ggfls. mit der rechten Maustaste in den GeoPlan. Über “Zoom to network” 
verschaffen Sie sich Überblick über das Entwässerungssystem, welches Sie gerade in diesem Moment 
aufbauen. Dies ist hilfreich, sollten Sie sich einmal im GeoPlan verirrt haben oder schnell eine 
Übersicht über das gesamte Gelände erlangen möchten.  
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Schritt 11: Erste Prüfung der importierten Schacht- und Haltungsdaten 
Auf dem ersten Blick scheint der Import funktioniert zu haben. Schächte und Haltungen sind 
verbunden. In vielen Schächten und Haltungen fehlen jedoch wichtige Attribute/Daten, die ergänzt, 
oder abgeleitet werden, bevor das Modell für eine hydraulische Simulation verwendet werden kann. 
Dies ist gleich deutlich zu erkennen, wenn Sie einen Haltungsstrang auswählen und in einer 
Längsschnittansicht öffnen: 

• Die Modellgruppe “Selection Group List” links in der Datenbank enthält eine Auswahlliste 
(“Selection List”). Ziehen Sie diese auf den GeoPlan, um eine gespeicherte Auswahl von 
Haltungen und Schächten (Haltungsstrang) anzuzeigen. 

 

• Öffnen Sie nun die Längsschnittansicht des ausgewählten Kanalnetzstrangs, in dem Sie auf 

das kleine Werkzeug  klicken (“New long section”). Dieses Werkzeug öffnet einen 
Längsschnitt auf Basis einer getroffenen Auswahl von Haltungen/Schächten. Verwechseln Sie 

dieses nicht mit dem Werkzeug  (Long Section Pick), mit welchem Sie gezielt einzelne 
Haltungen auswählen können. 

 

Aus der Längsschnittansicht geht deutlich hervor: unsere Kanalnetzdaten sind unvollständig. In der 
hydraulischen Modellierung sind unvollständige Kanalnetzdaten keine Seltenheit. Auch bei der 
besten Datenquelle sind immer wieder unvollständige Kanalnetzdaten vorhanden. 

Man könnte die fehlenden Datenelemente manuell ergänzen, aber bitte machen Sie dies heute aus 
Zeitgründen nicht. Generell mit der Arbeit in InfoWorks ICM gilt: wenn ein Arbeitsschritt sehr lange 
dauert, gibt es in der Regel Werkzeuge, die Sie anwenden können, um Zeit zu sparen.  
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Der schnellste und einfachste Weg, die fehlenden Daten zu ergänzen, ist die Verwendung des 
InfoWorks ICM Inference-Tools. Dieses kann verwendet werden, um fehlende Schachtdeckelhöhen, 
Sohlhöhen, undefinierte Rohrdurchmesser auf Basis vorhandener Daten und angrenzender 
Haltungen abzuschätzen und um geeignete Druckverlustkoeffizienten basierend auf dem Winkel 
festzulegen, mit welchem Haltungen in Schächte eintreten / diese verlassen. Mit wenigen Klicks. 

 

Schritt 12: Längsschnittansicht anpassen 

• Klicken Sie per Rechtsklicks auf den Längsschnitt und wählen “Properties”. Klicken Sie auf 
“Field Settings”, um die folgenden Einstellungen vorzunehmen. Hier lässt sich einstellen, 
welche Netzdaten auf einem Längsschnitt angezeigt werden. 

• Wählen Sie von der linken Auswahl “Node” und aktivieren Sie in der Auswahlliste “Ground 
level”, um die Geländehöhe anzuzeigen.  

• Wechseln Sie nun zur linken Auswahl “Conduit” und aktivieren in der Auswahl “Conduit 
Width”, “US Invert Level” und “DS Invert Level”. Wählen Sie “Save as Default”, Yes, OK und 
OK. 

 

 

5. Umgang mit unvollständigen Kanalnetzdaten 

 
• Vergewissern Sie sich, dass nur zwei Fenster geöffnet sind, nämlich GeoPlan („Neues 

Kanalnetzmodell“ und die Längsschnittansicht.  

 

• Klicken Sie in der Menüleiste auf “Window” -> “Tile horizontally”, um die Ansichten 
automatisch horizontal in der Benutzeroberfläche zu verteilen. Alternativ können Sie die 
jeweiligen Fenster auch manuell verschieben und bewegen. 
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Schritt 13: Prüfung der Kanalnetzdaten 
• Führen Sie nun eine Überprüfung des gesamten Kanalnetzmodells durch, um die Integrität 

der Kanalnetzdaten zu überprüfen.  

• Suchen Sie die Validieren-Schaltfläche  (“Validate”) und drücken Sie darauf. Durch die 
Validierung können wir eine grundlegende Konnektivitätsprüfung bzw. detaillierte technische 
Validierung durchführen. Modellnetze müssen diese Prüfungen bestehen, bevor sie in einer 
Simulation verwendet werden können.  

• Drücken Sie die OK- Taste, um die Netzvalidierung zu starten. 
 
Eine Reihe von Fehlern und Warnungen wird im Ausgabefenster am unteren Bildschirmrand 

angezeigt, und die Haltungen und Schächte mit Problemen werden im GeoPlan hervorgehoben.  

 

Wir werden nun wieder das Inferenz-Tool verwenden, um diese Probleme zu beheben.  
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Schritt 14: Ableitung fehlender Daten (Inferenzwerkzeug) 
Der GeoPlan und die Längsschnittansicht sollten geöffnet sein, ähnlich wie in Schritt 12 zu sehen.  

• Ziehen Sie die „Selection List“ aus der Modellgruppe „Selection List Group“ auf den GeoPlan 

• Öffnen Sie nun in der Datenbankansicht die Inferenz-Modellgruppe.  

Diese Gruppe enthält eine Reihe von Ableitungs-/Inferenzfunktionen (5).  
Diese sind nummeriert, um die optimale Reihenfolge anzuzeigen, in der sie in 
dieser Schulung angewendet werden sollten.  
Hinweis für die spätere Arbeit mit InfoWorks ICM: Wenn Objekte im GeoPlan 
ausgewählt sind, bearbeitet das Inferenzwerkzeug nur die ausgewählten 
Objekte. Wenn im GeoPlan keine Auswahl getroffen ist, wird das 
Inferenzwerkzeug auf alle Netzobjekte angewendet. 

• Ziehen Sie das Inferenzobjekt “1. Set Pipe Size” auf den GeoPlan. Rohrdurchmesserattribute, 
die früher fehlten, wurden nun ergänzt (abgeleitet auf Basis von umliegenden 
angeschlossenen Haltungen mit vorliegendem Rohrdurchmesserattribut). 

• Als nächstes, ziehen Sie das Inferenzobjekt “2. Set Inverts” auf den GeoPlan. Haltungen, 
denen Sohlhöhen fehlten, werden jetzt auf Basis von Haltungen (mit Sohlhöhen) korrigiert, 
die mit demselben Schacht verbunden waren. 

• Ziehen Sie nun das Inferenzobjekt mit dem Namen “3. Set Ground Levels” auf den GeoPlan. 
Für alle Schächte mit fehlenden Schachtdeckelhöhen werden diese jetzt basierend auf 
nahgelegenen Schächten mit vorhandenen Schachtdeckelhöhen festgelegt. 

Die abgeleiteten Werte, enthalten eine farbige Datenkennzeichnung in der Attributtabelle (zu sehen 
in Gelb im Längsschnitt). So halten wir dauerhaft fest, dass es sich um abgeleitete und nicht um 
vermessene Daten handelt und behalten als Modellierer und Partner/Kunde Übersicht über die 
vorhandene Datenqualität.  

Wenn Sie die Attribute zukünftig auf Basis besserer und geprüfter Daten ergänzen, können Sie dies 
über eine entsprechende Datenkennzeichnung festhalten. 

• Schließen Sie das Fenster der Längsschnittansicht und maximieren Sie das Fenster des 
GeoPlans. 

• Über die Schaltfläche  (“clear selection”) heben wir die Auswahl auf, so dass keine 
Schacht- und Haltungen mehr ausgewählt sind.  

• Wiederholen Sie nach Abschluss die zuvor ausgeführte Validierung. Klicken Sie auf  und 
wählen Sie OK. Nun sollten keine Warnungen mehr angezeigt werden (es werden lediglich 
zwei Informationsmeldungen angezeigt, die durch eine blaue Anzeige angezeigt werden. 
Diese können jedoch ignoriert werden). 

 

Tip: Sie können einzelne Bearbeitungsschritt in InfoWorks ICM rückgängig machen  (undo) bzw. 

wiederholen  (redo). 
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Hinweis: InfoWorks ICM zeigt nach einer Validierung drei Fehler- bzw. 
Warnungsstufen an.  

 

Wussten Sie, dass InfoWorks Bearbeitungsschritte automatisch zwischenspeichert? Ein klassisches 
Speichern entfällt. Speichern über die Schaltfläche  bewirkt, dass die Bearbeitungsschritte vom 
lokalen Zwischenspeicher in die Master-Datenbank übertragen werden. Würden Sie im Team 
arbeiten, hätten weitere Bearbeiter nun Zugriff auf die von Ihnen verrichtete Arbeit. 

Wenn Sie über die Schaltfläche speichern, wird die aktuelle Version des Modell-Netzwerks 
gespeichert. Dabei bleibt die frühere Version des Modell-Netzwerks erhalten.  

Die Daten des Kanalnetzes sind jetzt vollständig und validiert.  

• Schließen Sie die Längsschnittansicht und maximieren Sie 
das Fenster des GeoPlans, falls noch nicht geschehen. 

• Speichern Sie Ihr Modell über die Schaltfläche  ab 
(“Commit changes to master database”). Tragen Sie in das 
Textfeld ein, was Sie am Modell verändert haben. So 
behalten Sie Überblick, wer was und wann geändert hat. 

•  

In InfoWorks ICM können Sie jederzeit auf frühere Datenbestände zurückgreifen (über die commit 
history, s. Abbildung, mittels Rechtsklick auf Ihr Kanalnetzmodell).  

 

  

➔ Welchen Knopf drücken Sie, um ein Modellnetzwerk zu validieren? 
 

1.  
 

2.  
 

3.  
 
 

 

Quizfrage 1: 
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6. Haltungsflächen 

Einzugsgebietsdaten liefern uns wichtige Informationen über den Niederschlagsabfluss 
(Abflussbildung, Abflusskonzentration) von befestigten Oberflächen, den häuslichen Abflüssen 
(Trockenwetterabflüsse) sowie deren Zulauf zu Schächten.  

Schritt 15: Teileinzugsgebiete importieren: 
Uns liegt ein GIS-Datenbestand zu unserem Haltungsflächen vor, welchen wir nun importieren: 

• Öffnen Sie den Open Data Import Centre über das Menü: Network -> Import -> Open Data 
Import Centre. Wählen Sie nun anstelle von Node, -> Subcatchment -> Raw Shape File. 
Wählen Sie die Datei „Subcatchments.shp“ 
aus -> AutoMap -> Import -> Close. 

43 Teileinzugsgebiete (Subcatchments) wurden 

importiert.  

 

 

 

 

 

 

Hintergrundinformation: Landnutzung und Oberflächentypen 

Unseren Haltungsflächen werden wir eine Landnutzungsklasse zuordnen. In diesem Beispiel 

bezeichnen wir die Landnutzung als „Landnutzung 1” (land use 1), welche ein 

gemischtes Siedlungsgebiet darstellen soll. InfoWorks ICM kann bis zu 12 verschiedene 

Landnutzungen berücksichtigen. Die jeweiligen Teileinzugsgebiete haben einen unterschiedlichen 

Anteil an befestigter und unbefestigter Fläche (Straßen- und Dachflächen, Grünflächen), den wir 

berücksichtigen sollten. Die verschiedenen Oberflächentypen werden in InfoWorks ICM als “Runoff 

surfaces“ bezeichnet.  

Beispiel: Dieses Beispiel-Teileinzugsgebiet hat eine Gesamtfläche von 0.939 ha, ist als gemischtes 

Siedlungsgebiet definiert (land use 1) welches sich anteilig aus 2 versiegelten Oberflächentypen 

(runoff surface ID 1 & 2) und 1 unversiegelten Oberflächentyp (runoff surface ID 3) zusammensetzt.  
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Die jeweiligen Teileinzugsgebiete haben unterschiedliche Oberflächenbeschaffenheiten, deren 

Anteil/Zusammensetzung wir, wie in diesem Beispiel, individuell festlegen können. Dies wird für alle 

Teileinzugsgebiete durchgeführt. Aber keine Sorge: diese Informationen liegen uns bereits in einem 

externen Datensatz vor, welchen wir heranziehen möchten, um Arbeitszeit zu sparen. 

 

Schritt 16: Detaillierte Definition der Haltungsflächen 

In diesem Schritt werden wir Gebäude- und Flächenpolygone 

über einen GIS-Datenbestand importieren.  

Hinweis: Die SHP-Datei enthält alle Umrisse der jeweiligen 

befestigten Oberflächen (Gebäudeflächen und Straßenflächen 

bzw. runoff surface 1 und 2). Unsere Landnutzung besteht 

weiterhin aus dem jeweiligen Anteil unbefestigter Oberflächen 

per Teileinzugsgebiet. Dies kann automatisch aus der 

Flächendifferenz zwischen befestigten Oberflächen (runoff 

surface 1 und 2 zusammen) und der Gesamtfläche der jeweiligen 

Teileinzugsgebiete berechnet werden. 

• Öffnen Sie zunächst den Open Data Import  Centre über das Menü: Network -> Import -> 
Open Data Import Centre. Wählen Sie anstelle von Node, -> Polygon -> Raw Shape File. 
Wählen Sie die SHP-Datei „Polygons.shp“ aus. Klicken Sie auf AutoMap, Import und Close, 
um die Flächenpolygone zu importieren.  

534 Polygone wurden importiert.  

• Sollten Sie die Polygone im GeoPlan nicht automatisch sehen, klicken Sie mit der rechten 
Maustaste auf den GeoPlan -> Properties & Themes…, scrollen Sie etwas nach unten bis Sie 
den Object Layer „Polygon“ sehen. Aktivieren Sie hier Polygon (Haken bei Display) und 
wählen Sie OK. 

Die importierten Polygone bilden alle befestigen Oberflächen ab (runoff surface 1 und 2). Mit Schritt 

15 und 16 liegen uns folgende Informationen vor: 

• Begrenzungen der Teileinzugsgebiete (damit auch 
die jeweilige Flächengröße der 
Teileinzugsgebiete) 

• Begrenzungen der jeweiligen befestigen Flächen 
(Gebäude- und Straßenflächen) innerhalb der 
Teileinzugsgebiete. 
 

Für jedes Teileinzugsgebiet werden wir nun die jeweilige 

Verteilung der 3 Oberflächentypen/runoff surfaces 

berechnen. Dafür verwenden wir gleich das Werkzeug 

„Area Take Off“. 
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Wir müssen jedoch noch einen wichtigen Schritt erledigen. In den Einstellungen der Teil-

einzugsgebiete muss festgelegt werden, dass diese jeweils aus 3 verschiedenen Oberflächentypen 

bestehen (runoff surface 1, 2 und 3). Außerdem müssen wir die entsprechenden Attribute so 

konfigurieren, dass der jeweilige Anteil (in ha) auf Basis der gerade importierten Polygondaten 

berechnet wird. 

• Klicken Sie auf die Schaltfläche  (Grid Windows) und 
wählen Sie „New subcatchments window“, um die 
tabellarische Ansicht der Teileinzugsgebiete zu öffnen.  

• Navigieren Sie mit soweit nach rechts (über den Schieber s. 
Abbildung), bis Sie zur Spalte „contributing area (ha)“ 
gelangen. 

• Selektieren Sie gesamte Spalte in dem Sie auf die Spaltenüberschrift „contributing area (ha)“ 
Klicken.  

• Klicken Sie dann mit der rechten 
Maustaste in eine der Spaltenzellen und 
wählen Sie „Flags“ -> und „#G“ 

 

 

 

 

 

 

 

• Vergewissern Sie sich, dass keine Auswahl aktiv ist. Klicken Sie auf die Schaltfläche  
(“clear selection”). 

• Klicken Sie mit der linken Maustaste auf den Reiter des Kanalnetzmodells. 

 

• Klicken Sie jetzt auf „die Menüleiste „Model“ -> Subcatchment -> Area Take Off… 
• Wählen Sie Polygons und OK.  
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• Klicken Sie mit der rechten Maustaste auf den Reiter 
des Kanalnetzmodells -> Close other tabs. 
 
 

Das Verhältnis zwischen befestigten (runoff surface 1, 2) und 

unbefestigen (runoff surface 3) Oberflächen sollte nun für jedes 

Teileinzugsgebiet auf Basis der Polygondaten berechnen worden 

sein. 

• Klicken Sie auf das -Symbol (Properties) und 
klicken anschließend eines der Teileinzugsgebiete 
im GeoPlan an. Das Eigenschaften-Fenster öffnet 
sich (s. Abb.). 

• Navigieren Sie mit dem Schieber innerhalb des 
Eigenschaften-Fensters (Properties) nach unten, 
bis Sie die Einträge für Runoff surfaces absolute 
(ha) sehen (runoff surface 1, 2 und 3).  

 

Sehen Sie unten links die verschiedenen Tabs (Properties, 

Master Database, job progress)?  

• Klicken Sie auf „Master Database“ um wieder zum 
Fenster der Master-Datenbank zu wechseln. 

 

 

 

Wir sind nun fast fertig mit unserem Kanalnetzmodell. Vielleicht ist Ihnen aufgefallen, dass neben 

den Attributen der runoff surfaces rote Warnblöcke zu sehen sind (s. Abb.). Dies sind 

Probleme/Konfigurationsfehler, die wir im Folgenden beheben: 

Schritt 17: Letzter Schliff 
Wir verwenden eine externe CSV-Datei, um die letzten Attribute/Modellparameter in unserer 
Kanalnetzdatenbank zu ergänzen:  

• Es ist noch erforderlich die Niederschlags-Abflussbildung- bzw. Konzentration der runoff-
surfaces 1, 2 und 3 zu definieren. In InfoWorks sind diverse Ansätze implementiert 
(Wallingford, Grenzwert, Kaskade, und viele mehr). In diesem Beispiel verwenden wir 
Wallingford. 

• Außerdem: Gedanklich haben wir das bereits festgehalten, aber wir müssen noch für alle 
Teileinzugsgebiete die Landnutzung 1 (land use 1) definieren, so dass diese sich aus den 
runoff surfaces 1, 2 und 3 zusammensetzt. Dies wird uns auch durch die roten Warnblöcke in 
der letzten Abbildung angedeutet.  

• Vorbereitend zur anschließenden hydraulischen Simulation ergänzen wir unser Modell noch 
mit einer Reihe von Standard-Parametern und Modellkoeffizienten.  
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Die hierfür erforderlichen Parameter sind alle in einer CSV-Datei enthalten, welche wir direkt 
einlesen, um Zeit zu sparen: 

• Klicken Sie im Menü auf Network -> Import -> Update from CSV files 
• Belassen Sie im nächsten Dialog alle vorhandenen Einstellungen und drücken Sie OK.  
• Wählen Sie nun die Datei “parameter_import.csv” aus dem CSV-Ordnerverzeichnis aus und 

klicken Sie OK. Die Datei wird gelesen und das Dialogfeld zur Dateiauswahl wird erneut 
angezeigt, damit Sie eine andere CSV-Datei auswählen könnten, falls erforderlich. Wir haben 
nur diese eine Datei zum Lesen, also drücken Sie diesmal die Schaltfläche Cancel, um 
abzubrechen.  

Es wird ein Bericht erstellt, der die Anzahl der neuen und/oder aktualisierten Elemente bestätigt, die 
in das Netzwerk importiert wurden.  

• Schließen Sie den Bericht, um zur normalen GeoPlan-
Ansicht zurückzukehren. Klicken Sie dazu z.B. mit der 
rechten Maustaste auf den Reiter des Kanalnetzmodells 
-> Close other tabs. 

 

 

 

Der letzte Schritt besteht darin, das Netzwerk zu validieren, um sicherzustellen, dass alle 

Einzugsgebietsdaten konsistent sind und mit dem unterirdischen Kanalnetz verbunden sind.  

• Validieren Sie das Modellnetz. Klicken Sie auf die Schaltfläche  und OK. 
Es sollten keine neuen Fehler- oder Warnmeldungen angezeigt werden (die beiden 
vorherigen blauen Meldungen bleiben erhalten, können jedoch weiterhin ignoriert werden).  

• Das Modell ist jetzt fertig. Schließen Sie die GeoPlan-Ansicht und speichern ( ) Sie das 
Modellnetz ab, um das fertige Modell in die Master-Datenbank zu übertragen.  
Halten Sie die Bearbeitungsschritte fest und klicken Sie OK.  
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7. Durchführung einer hydraulischen Kanalnetzberechnung 
Wir sind jetzt in der Lage, eine hydraulische Simulation mit unserem neu erstellten Kanalnetzmodell 
durchzuführen. Die Datenbank enthält bereits eine Niederschlagsdatei mit einem Starkregenprofil. 

• Innerhalb der Master-Datenbank finden Sie die Modellgruppe “Run Group”. Wenn Sie auf 
diese mit der rechten Maustaste klicken, wählen Sie New InfoWorks -> „Run“, um einen 
neuen Rechenlauf anzulegen.  

• Geben Sie dem Rechenlauf einen Namen (z.B. “Rechenlauf 1”).  
• Ziehen Sie das Modellnetzwerk “Eigenes Kanalnetzmodell” in das zugehörige Feld „InfoWorks 

network“.  
• Ziehen Sie auch die Regendatei “Starkregen” aus der Rainfall Group in das entsprechende 

Feld.  

 

• Den Zeitschritt (Timestep) belassen wir auf 60 Sekunden 
• Stellen Sie den “Results timestep multiplier” und den “ Gauge timestep multiplier” jeweils 

auf 1. 
• Die zu simulierende Rechenlaufzeit (“Duration”) stellen wir auf 120 Minuten (2 Stunden). 
• Klicken Sie auf die Schaltfläche “Run simulations”, um die Simulation zu starten. Sie erhalten 

eine Option, auf welchem Rechner die Simulation ausgeführt werden soll. Standardmäßig ist 
dies auf “This Computer” eingestellt (InfoWorks ICM kann Simulationen aber auch auf andere 
Rechner auslagern). Drücken Sie OK, um die Simulation auf dieser Maschine zu starten.  

 

Die Simulation ist nach wenigen Sekunden abgeschlossen.  
Wir werden nun die Ergebnisse anzeigen und analysieren. Welche Optionen hier zur Verfügung 
stehen, erfahren Sie im nächsten Abschnitt. 
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8. Ergebnisauswertung 

Berechnungsergebnisse können innerhalb der Benutzeroberfläche von InfoWorks ICM auf vielfältige 
Weise betrachtet werden. Die beiden beliebtesten Ansichten sind die Vogelperspektive (GeoPlan) 
und die Längsschnittansicht. 
Es gibt jedoch auch eine 3D-Schachtansicht, die sehr nützlich ist, wenn Sie die Höhe des Wassers in 
einem Schacht untersuchen möchten, sowie Standard-Diagrammansichten und Ergebnistabellen zur 
Analyse von Abflüssen, Wassertiefen und Fließgeschwindigkeiten. Oder custom-reports und 
Überflutungsvolumina-Berichte. 

Die unterschiedlichen Ergebnisse von InfoWorks ICM lassen sich am besten anhand farbiger 
Visualisierungen betrachten. Fast jedes Ergebnisattribut kann im GeoPlan visualisiert werden.  
Eine Reihe nützlicher Visualisierungsvorlagen wurde für Sie vorbereitet und diese sind bereits in der 
Datenbank enthalten.  

Farbige GeoPlan-Visualisierungen 

• Öffnen Sie das Kanalnetzmodell “Eigene Kanalnetzmodell”, in dem Sie dieses auf den 
GeoPlan ziehen. Ist Ihr Kanalnetzmodell bereits im GeoPlan geöffnet, fahren Sie fort. 

Innerhalb der “Theme Group” finden Sie 3 gespeicherte Visualisierungen: 

• 1_Modellaufbau (mit dieser Visualisierungsvorlage haben Sie bis jetzt gearbeitet) 
• 2_Netzbezogen + Durchmesser (Fokus: Kanalnetz und Durchmesser)  
• 3_Netzkapazität / Überstauvolumina (Fokus: Kanalnetzkapazität, Überflutungshotspots) 

 
Die verschiedenen Visualisierungen schauen wir uns nun näher an.  

• Ziehen Sie das Theme „2_Netzbezogen + Durchmesser“ auf den 
GeoPlan, um das Kanalnetzmodell mit einer anderen “Brille” zu 
sehen.  

• Ziehen Sie weitere thematische Darstellungen (Themes) auf den 
GeoPlan, um. Dabei wird nichts an den Daten geändert, lediglich 
deren Darstellung. 
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Welche Haltung hat den größten Rohrdurchmesser? 
Wir schauen uns nun die Haltungsdurchmesser in einer Tabellenansicht an, um herauszufinden, 
welche Haltungen den größten Rohrdurchmesser hat. 

• Klicken in der oberen Menüleiste auf Window -> Grid windows -> „New links windows“ oder 

alternativ auf  („grid windows“ -> new links windows). 

• Navigieren Sie im Tab „Conduit“ über den Schieber etwas weitere nach rechts, bis Sie die 
Spalte „Width (mm)“ sehen (Rohrbreite). Klicken Sie mit der rechten Maustaste in einen der 
Width-Zellen und wählen „Sort Descending“ (absteigende Sortierung).  

Tip: Sie können die Spaltenbreite ähnlich wie in einer Tabellenverarbeitungssoftware (Z.B. Excel) 

verändern oder einzelne Spalten einfrieren (free columns).  

In den ersten Zeilen sollten Sie Haltungen mit einem Durchmesser von 525 mm sehen.  

 

 

➔ Wieviele Haltungen haben die Rohrbreite 350 mm? 
 

1. 6 
 

2. 2 
 

3. 1 
 

Quizfrage 2: 
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Tip: Klicken Sie mit der rechten Maustaste auf den Tab „Conduit“ 

(s. Abbildung) -> close Tab.  

 

 

9. Kanalnetzkapazität und Überstauanalyse 

Kapazitäts- und Überflutungsprüfung im GeoPlan 

• Ziehen Sie das Theme „3 Kanalnetzkapazität / Überstauvolumina“) auf den GeoPlan 

• Laden Sie nun die Berechnungsergebnisse in den GeoPlan, um mit der Ergebnisauswertung 
zu starten. Öffnen Sie dazu die Run-Gruppe in der Master-Datenbank, und ziehen Sie die 
Simulation des Rechenlauf 1 (“Starkregen”) in den GeoPlan. 

 

Das Theme („Kanalnetzkapazität / Überstauvolumina“) zeigt Ihnen drei interessante 
Ergebnisattribute an: 

• Kanalnetzüberlastung („surcharge“), je nach Wasserstand im Bezug zum Rohrscheitel. 
• An welchen Schächten es zum Überstau kommt (flood depth (m)). 
• Überstauvolumina (flood volume), d.h. Überstau (m³) aus Schacht  

 
Wiedergabe der Berechnungsergebnisse 
Eine wichtige Funktion innerhalb InfoWorks ICM ist die Wiedergabe der Berechnungsergebnisse 
über die Symbolleiste: 
  

Zurückspulen 1 Zeitschritt zurück Pausieren 1 Zeitschritt vor 

Play Video aufzeichnen Dauerschleife Zum Ende springen 

Wiedergabe-

Einstellungen 

Maxima 

anzeigen 

Ergebnisse aus 

Darstellung entfernen 
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Darstellung der Maxima / Überflutungshotspots 

• Klicken Sie in der Ergebniswiedergabeleiste auf , um die Maxima zu sehen - sozusagen 
den Wort-Case im Kanalnetz - unter den modellierten Randbedingungen (Starkregen-
Niederschlag). 

• Falls noch nicht geschehen, ziehen Sie das Theme „3 Kanalnetzkapazität / 
Überstauvolumina“) auf den GeoPlan.  

• Klicken Sie ggfls. mit der rechten Maustaste auf den GeoPlan -> Zoom to network, um das 
gesamte Kanalnetz zu sehen. 

 
 

Kanalnetzüberlastung (surcharge) 

Die örtliche Überlastung des Kanalnetzes wird je 

nach Füllstand im Kanal durch farbige 

Haltungslinien dargestellt. Zu sehen sind 

Wertebereich zwischen < 0.1 und 2: 

• < 1: teilgefüllter Kanal 
• 1: teilweise eingestaute Haltung 

(Vollfüllung am Rohranfang oder am 
Rohrende) 

• 2: Vollfüllung über die gesamte 
Haltungslänge (am Rohranfang und am 
Rohrende) 

 

Die in magenta dargestellten Haltungen (surcharge-Wert: 2) sowie die dunkelblau dargestellten 

Haltungen (Surcharge-Wert: 1) stellen Engpässe im Kanalnetz dar.  
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Teilweise eingestauter Kanal (Surcharge-Wert: 1). 

Einstau am Rohrende). Kein Überstau findet statt: 

 
 

 

Vollfüllung über die gesamte Haltungslänge (Surcharge-Wert: 2).  

Einstau am Rohranfang und Rohrende). Kein Überstau findet statt: 
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Teilweise bzw. vollständiger Einstau muss, wie in den letzten beiden Abbildungen zu sehen, nicht 

bedeuten, dass es an den Schächten zum Überstau kommt. Aber Sie erkennen die Haltungen, in 

denen der zu entwässerndem Abfluss die Rohrkapazität überschreitet (Kanäle sind eingestaut, teils 

stauen diese aber auch über). 

 

Überstautiefe aus Schacht (flood depth) 

Die thematische Darstellung stellt farbige Punkte dar. Je nach Farbe ist zu erkennen, ob Schächte 

überstauen oder ob noch „Luft“ bzw. Kapazität im Kanalnetz vorhanden ist, bevor diese überstauen: 

• Grüne Punkte zeigen Schächte, bei denen noch mehr als 20 cm unter Geländeoberkante an 
“Freibord” vorhanden ist. Unter einem Starkregenereignis wie diesem, sind entsprechende 
teilweise Schächte eingestaut, aber diese stauen nicht über.  

• Gelbe Punkte zeigen Schächte an, in denen der auftretende Wasserstand so hoch ist, dass es 
beinahe zum Überstau kommt. Zwischen Geländeoberkante und Schachtwasserstand sind 20 
cm oder weniger „Freibord“. 

• Blaue Punkte stellen Schächte dar, bei denen es zum Überstau kommt 
 

 
 

 

Wo sind die Überflutungsschwerpunkte („Hotspots“)? 

Auf Basis dieser Informationen können Sie farbig einsehen, an welchen Stellen im Netz 

Überflutungen auftreten. Wie groß diese sind (in m³ Überstauvolumen) und wo im Netz die 

Überflutungsschwerpunkte liegen erkennen Sie an der Größe der angedeuteten blauen Kreise an 

überstauten Schächten: 

 

 

  



27 
 

  

Überstauvolumina: 

• Grüne Punkte: kein Überstau. 
• Blaue Schächte: Überstauvolumina zwischen 0.01 < 2 m³. 
• Blaue Schächte mit zwei blauen Ringen:  Überstauvolumina zwischen 2 < 10 m³. 
• Blaue Schächte mit vier blauen Ringen: Überstauvolumina > 10 m³. 

 

 
 

Nahezu alle Attribute und Ergebnisattribute lassen sich über thematische Darstellungen anzeigen. 

 

Wesentlicher Vorteile dieser Betrachtungsweise ist es, dass Sie als hydraulischer „Modellierer“ sehr 

effizient Ihre Berechnungsergebnisse auch an „Nicht-Modellierer“ präsentieren können und die 

Darstellungsweise speziell an Ihre Audienz und Aufgabe anpassen können.  

Es hilft Ihnen auch in der Risikokommunikation und in Workshops, Audits. Wenn Sie zum Beispiel mit 

besorgten Zielgruppen arbeiten, die keine hydraulischen Experten sind, schlichtweg aber wissen 

möchten, warum Ihre Erdgeschosswohnung durch ein Starkregenereignis überschwemmt wurde 

(und die Ihrer Nachbarn oder Bekannten nicht), kann eine farbige Darstellungsart erhebliche Vorteile 

gegenüber einer detaillierten tabellarischen Darstellung haben.  

 

Die spezifischen Darstellungsweisen lassen sich umfassend in den Darstellungseigenschaften des 

GeoPlans konfigurieren (über Rechtsklick im GeoPlan -> Properties & Themes). Dies geht jedoch über 

den Umfang dieser Schulung hinaus. Wir möchten Ihnen an dieser Stelle lieber weitere Funktion 

zeigen, mit denen Sie detaillierte Berechnungsergebnisse einsehen können. 
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Darstellung der Berechnungsgerbnisse über das Eigenschaften-Fenster 
Bisher haben wir die Maxima / Worst-Case-Berechnungsergebnisse betrachtet.  

• Klicken Sie auf die Schaltfläche „Rewind“  (Zurückspulen – s. Erläuterung 
Ergebniswiedergabe auf S. 23), um zum Beginn der Simulation zurückzukehren. 

• Sehen Sie die Zeitachse (s. rote Umrandung in Abb, Minute 50)? Klicken Sie darauf, um zu 
einem spezifischen Zeitschritt der Berechnungsergebnisse zu springen.  
 

Tip: Über die Schaltfläche  („step-forward“) können Sie einzelne Zeitschritt (Minuten) 
vorspulen.  

 

• Klicken Sie doppelt (oder mit der Schaltfläche  (Properties)) auf einen beliebigen Schacht 
(oder auf eine beliebige Haltung), um die Ergebnisattribute einzusehen.  

• Im Eigenschaftenfenster sehen Sie nun die berechneten Ergebnisattribute zum ausgewählten 
Zeitschritt (s. blaue Umrandung in Abb., Minute 50) 

Das Ergebnisattribut „Flood volume (m³) beträgt in diesem Schacht zu diesem Zeitschritt 0.3 m³.  

• Nun betrachten wir die Überstautiefe (m): flood depth (m). Springen Sie ein paar Zeitschritt 
vor- und zurück, um den zeitlichen Verlauf der Überstautiefe (m) im Fenster der 
Schachteigenschaften zu sehen. 

Videoanimierte Längsschnitte 

• Klicken Sie links unten auf den Tab „Master Database“, um zum 
Datenbankfenster zu wechseln.  

• In der Datenbank öffnen Sie die Modellgruppe “Selection List Group” und ziehen Sie die 
Auswahlliste “Strang” auf den GeoPlan.  

• Mit der rechten Maustaste auf den GeoPlan, wählen Sie „Zoom to selection“. 

• Klicken Sie nun auf  (New long section view), um eine Längsschnittansicht des 
ausgewählten Strangs zu öffnen.  
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• Klicken Sie auf zurückspulen  (rewind) und heben Sie die Auswahl auf  
• Sie sehen nun einen videoanimierten zeitlichen Verlauf der Wassertiefe im Kanal, den 

Einstau und Überstau.  
• Klicken Sie in der Zeitleiste der Ergebniswiedergabe innerhalb der Längsschnittansicht auf 

Minute 50. 

 

Ganglinien 

Schacht 75_060 staut zu diesem Zeitschritt über (s. blauer Punkt mit blauen Ringen) im Längsschnitt.  

• Suchen Sie das (Graph)-Werkzeug, klicken Sie darauf. Sie können dieses nutzen, um 
Ganglinien zu erzeugen, in dem Sie auf einen Schacht, eine Haltung klicken (sei es im GeoPlan 
oder wie hier in der Längsschnittansicht) 

• Klicken Sie mit dem  nun innerhalb der Längsschnittansicht auf den blauen Punkt 
(Schacht 75_060, und wählen Sie „Flood depth (m)“ aus, und klicken Sie OK, um eine 
Ganglinie der Überflutungstiefe zu erzeugen: 

  

 

Quizfrage 3:  

• Kehren Sie zum GeoPlan zurück. Klicken Sie mit der 
rechten Maustaste auf den Reiter des Kanalnetzmodells 
und -> Close other tabs.  

• Klicken Sie mit der rechten Maustaste in den GeoPlan -> Zoom to network.  

• Klicken Sie nun auf , um die Maxima-Werte einzusehen.  

• Heben Sie die Auswahl auf – klicken Sie auf die Schaltfläche  
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• Sollten sie noch das “Diagramm-Symbol” ausgewählt haben, drücken Klicken Sie die Escape-
Taste auf Ihrer Tastatur, um das Auswahl-Werkzeug zu aktivieren. Klicken Sie alternativ auf 

das Auswahl-Werkzeug (Select). 

Sehen Sie die beiden gelben Schächte? 

• Drücken Sie die STRG-Taste gedrückt 
und klicken Sie beide Schächte, 
während STRG gedrückt ist, um beide 
gelben Schächte auszuwählen. Lassen 
Sie STRG nun los. 

• Klicken Sie nun auf die Schaltfläche 

 („Graph selected objects“), 
wählen Sie in der linken Spalte „Flood 
depth (m)“ an und klicken Sie OK. 

 

• Gelbe Schächte sind laut unserer Definition kurz vor dem Überstauen. Die Überstautiefe 
(flood depth) sollte entsprechend der Definition unserer gelben Schächte negative Werte 
zwischen– 0.2 und <0 annehmen (wären diese Werte positiv, würden die Schächte 
überstauen). 

 

 

 

 

  

Im GeoPlan sehen Sie mehrere Schächte, bei denen es fast zum Überstau kommt (gelbe Schächte). 

➔ Welcher Schacht ist am Nächsten kurz vor dem Überstauen?  
1. 40_070 

 
2. 40_050 

 
3. NJ41655301 

Quizfrage : 3 
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Quizfrage 4:  

Wir möchten nun die maximale Fließgeschwindkeit in einer bestimmten Haltung ermitteln, und zwar 

in: Haltung „50_090.1“ (fünfzig Unterstrich null neunzig Punkt 1) 

• Diese könnten wir in der Tabellenansicht suchen, aber 

wir suchen diese über die Suchfunktion  („Find in 
GeoPlan“). Diese Funktion ist auch über die obere 
Menüleiste „GeoPlan“ zu erreichen. 

• Tragen Sie in das Suchfeld den Haltungsnamen Haltung 
„50_090.1 ein und klicken Sie auf „Find“, um zu dieser 
Haltung zu navigieren (diese wird automatisch 
selektiert/rot markiert). 
 

Wie lautet die maximale Fließgeschwindkeit (m/s) in Haltung 50_090.1?) 

wäre unsere nächste Quizfrage.   

1. Aktivieren Sie die Schaltfläche Eigenschaften  („Properties“) und 
klicken Sie damit auf die Haltung „50_090.1“.  
Alternative zum Öffnen der Properties: per Doppelklick. 

Hinweis: Fließgeschwindkeiten werden in Rohrrichtung am Rohranfang („US 

velocity“) und Rohreende („DS velocity“) berechnet 

(US/DS=upstream/downstream).  

 
 

  

➔ Was ist die maximale Fließgeschwindkeit in Haltung 50_090.1 am Rohranfang? 
 

1. 0.22 m/s (auf 2 Kommastellen gerundet) 
 

2. 1.26 m/s (auf 2 Kommastellen gerundet) 
 

3. 1.49 m/s (auf 2 Kommastellen gerundet) 

4.  

Quizfrage 4: 
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Überflutungsbericht / Quizfrage 5:  
Wir möchten nun wissen, an welchem Schacht das Überstauvolumen (m³) am größten ist.  

• Über  gelangen Sie wieder zu den Maxima, falls noch nicht geschehen.  

• Klicken Sie links unten auf den Tab „Master Database“, um zum 
Datenbankfenster zu wechseln.  

• Verwenden Sie das Theme „Kanalnetzkapazität / Überstauvolumina“. Klicken Sie mit der 
rechten Maustaste auf den GeoPlan -> Zoom to network.  

• Es gibt einen speziellen Überflutungsbericht (Wählen Sie „Results“ -> Grid report -> Flood 
volume report.  

• Ziehen Sie den Rechenlauf (Run) aus der Run-Group in das “Sim”-Fenster des “Flood Volume 
Report” und wählen Sie “produce Grid”. Schließen Sie den Dialog ( ). 

 

• Der Überflutungsbericht wird geöffnet. Beantworten Sie nun Quizfrage 5.  

 

 

 
  

➔ An welchem Schacht ist das Überstauvolumen am größten? 
 

1. Schacht 40_070  
 

2. Schacht NJ41659301 
 

3. Schacht 75_060 

Quizfrage 5: 
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Arbeitsplätze einrichten 
In InfoWorks ICM können Sie Arbeitsplätze („Workspaces“) speichern, d.h. vorgefertigte Ansichten, 
Fenster und Ergebnisdarstellungen. Sie können diesen in der Datenbank speichern und die exakte 
Zusammenstellung wieder aufrufen. Dies ist eine beliebte Funktion, um Berechnungsergebnisse 
ähnlich einer Präsentations-”Slide” vorzustellen. 

• Stellen Sie sich einen eigenen Workspace zusammen: 
o Schließen Sie den zuvor erstellten Überflutungsbericht (flood report)  
o Kehren Sie zum GeoPlan zurück.  

Klicken Sie dazu mit der linken Maustaste auf den Reiter des Kanalnetzmodells.  
o Ziehen Sie aus der Selection Group die „Strang“ auf den GeoPlan und öffnen Sie eine 

neue Längsschnittansicht (  (New long section view). 
 

Einmal erstellte Ansichten und Visualisierungen lassen sich als festen Arbeitsplatz (“Workspace”) 
speichern, in dem Sie in einer Modell-Gruppe mit der rechten Maustaste -> New InfoWorks  -> 
Workspace wählen und einen Ablageort innerhalb der Datenbank wählen, wo dieser gespeichert 
werden soll. 

• Speichern Sie sich nun Ihr Workspace ab. Klicken Sie mit der rechten Maustaste auf die 
Modellgruppe „Workspace Group“ -> New InfoWorks -> Workspace und geben Sie Ihrem 
Workspace eine Bezeichnung (z.B: Überflutungsschwerpunkt). 

• Spulen Sie nun die Berechnungsergebnisse zurück (rewind)   
• Schließen Sie alle Tabs/Fenster (Rechtsklick auf den Tab „Neues 

Kanalnetzmodell“ -> Close all tabs). 
Ihre Benutzeroberfläche sieht nun anders aus. 

• Öffnen Sie den gerade gespeicherten Workspace (Doppelklick). Ihr Arbeitsplatz (Workspace) 
wird wiederhergestellt, und zwar so wie Sie ihn zuvor gespeichert haben (Maxima-Ergebnisse 
geladen, GeoPlan mit hinterlegter thematischer Darstellung und Längsschnittansicht 
geöffnet). 
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Ende der Schulung: 

Die Schulung zur Kanalnetzmodellierung mit InfoWorks ICM ist hiermit fertig. Herzlichen 

Glückwunsch und vielen Dank, dass Sie mitgemacht haben!  

Vergessen Sie nicht Ihre Quizantworten aufzuschreiben. 

Wir hoffen sehr, dass Sie den Kurs genießen konnten und dieser zu ihrer beruflichen und 

persönlichen Weiterbildung beigetragen hat.  

Gerne können Sie weiter in der virtuellen Maschine mit InfoWorks ICM arbeiten. Wenn Sie Ihre 

Arbeit mit InfoWorks ICM abschließen, wählen Sie im Startmenü (Windows Button) -> Power -> 

Disconnect. 

 

On-demand-Webinar zur 2D-Modellierung 

In dieser Schulung haben wir uns mit der Kanalnetzmodellierung auseinandergesetzt und 
ausschließlich 1D gerechnet (1D-hydrodynamische Kanalnetzmodellierung). In diesem Beispiel 
wurden Sie in die Lage versetzt, eigens zu berechnen, an welchen Schächten es zum Überstau 
kommt, wie groß das Überstauvolumina ist, wo die Hot-Spots und Schwachstellen im Kanalnetz 
liegen. 

Damit kennen wir die Überflutungshotspots. Jedoch, wissen wir nicht wie sich das überstaute 
Volumen aus dem Schacht auf der Gelände/Straßenoberfläche ausbreitet, an welchen Schächten es 
ggfls. wieder eintritt bzw. auf welchen Grundstücken/Liegenschaften die Wassermenge zu 
Problemen führt.  

In unserem Webinar am 19. Juni (10:30) lernen Sie über InfoWorks ICMs Fähigkeiten in der 2D-
Oberflächenabflussmodellierung und in der gekoppelten 1D/2D-Simulation.  
Thema: 7 Kernaspekte der urbanen 2D-Überflutungsmodellierung. 

Wir freuen uns, wenn Sie dabei sind! 

 

 

  

https://www.innovyze.com/en-us/webinars/emea-on-demand-webinar-7-kernaspekte-der-urbanen-2d-%C3%BCberflutungsmodellierung
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10. Übermittlung der Quizantworten 

Um Ihr Schulungszertifikat anzufordern, möchten wir Sie bitten uns Ihre Antworten außerhalb der 
virtuellen Maschine zukommen zu lassen, da der Internetzugriff in der virtuellen Maschine aus 
Sicherheitsgründen eingestellt ist. 
 
Nutzen Sie daher den Weblink zu Outgrow, den Sie mit Ihren Schulungsunterlagen erhalten haben. 
Zum Quiz: https://innovyze576.outgrow.us/innovyze576-42 
 

 

 

Kontakt Vertrieb und Support (DACH) 
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